Software FAQ Lists for
TruEmbroidery

Installation

Listed versions: Not Applicable

IN020 When | try run an installation file | get a security warning and | cannot
continue.

Some installations may cause the message 'XXX can't be opened because it is from an unidentified developer' to
appear when run.

If you see this warning message (see below) then follow these instructions to install:

1. Click OK on the warning message to close it.

2. Ctrl-click on the file in your Downloads folder.

3. From the shortcut menu that appears, select Open.
4. Now the dialog reappears but with an Open button.
5. Click the Open button to continue the installation.

“TruEmbroidery.pkg” can't be opened
. . because it is from an unidentified
@ developer.
Your security preferences allow installation of only

apps from the Mac App Store and identified
developers.

Safari downloaded this file today from
www._emnetsoftware .eu.

TruE Configure

Listed versions: 2.1

ccoo1 Warning. Some TruE apps still appear to be running. Do you really want
to reset all modules?

This message is displayed if you select Reset All Apps in the Utilities tab while other TruEmbroidery™ Software
apps are running. Click Cancel, or use Quit Open TruE Apps to close all open apps.



ccoo2 Application could not be shut down. TruE XX could not be quit. Please
shut this app down manually.

This message is displayed if you select Quit Open TruE Apps in Reset All Apps when, for instance, a dialog is
open or you have unsaved changes in a TruEmbroidery™ Software app. Click OK, and then shut the app down
manually.

EC003 Can | have the TruE Machine app automatically start when | turn on my
computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System, click on the Users & Groups icon.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right hand pane of that window.

. Click on the + icon on the right hand pane of that window. An Open dialog will appear.

. On the left hand pane - under the Favorites section; click on the Applications entry.

. In the right hand pane, scroll down the list of apps until you come to the TruE Machine entry.

. Select the TruE Machine entry and click on the Add button.

. You will now see TruE Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.

O©oo~NO O~

When you next log into your computer; the TruE Machine app will automatically run.

EC004 Can | connect more than one embroidery machine to my computer with
TrukE Machine?

No, there is not the ability to have two embroidery machines connected at the same time; and be able to send a
designs to the first embroidery machine and then to the second embroidery machine.

In a scenario such as that; you are advised to:

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMBS5 folder, while for the MC11000 and MC 12000 they must
be placed in the Embf folder.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."



Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you
to choose a color. The color set by default for your TruEmbroidery™ Software is 127, 127, 127 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you
to choose a color. The color set by default for your TruEmbroidery™ Software is 211, 233, 255 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in TruE™ Configure to return the toolbar and windows in the app to their default settings.

To return the icons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the default
icon set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any TruEmbroidery™ Software apps that are open.

2. Click the TruE™ Configure icon in the Launchpad, or double-click the TruE™ Configure icon in the Finder.
3. Click the Utilities tab.

4. Click Reset All Apps.

5. Click the Quit Open TruE Apps button to close all open apps.

6. Click the Reset All Apps button.

Note: If some TruE apps are still open, a message will appear, saying that some apps appear to be running. Click
OK to close all running TruE apps, or click Cancel.

The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color will be replaced with the nearest match in the
Import Thread Range you have set in TruE™ Configure. You can alter it to any other color if desired. To check for
the latest updates for the TruEmbroidery™ Software, use Smart Update in TruE™ Configure.

GE010 No dongle attached. Cannot open or use application (7).

This message will appear when trying to start an app if the TruEmbroidery™ Software cannot detect the dongle
(data protection device). Ensure the dongle is plugged into a free USB port of your computer

GE011 No dongle attached. Cannot open or use application (33).

This message may appear if you try to use TruE™ Create shortly after starting or logging into your computer,
before the system is fully ready. Wait for a few seconds and try again.

GE026 Not enough memory available to perform function.



This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE039 Information About Colors in TruEmbroidery™ Software Files

The TruEmbroidery™ Software will display threads in a file in the same way on any computer where it is installed.
That is, the colors used will be the same even if they are reproduced slightly differently on different monitors. You
can print a worksheet to see the colors and color names used in a particular design. This is true, even if you do
not have all the threads in a design defined in the database on your computer. This is because a TruEmbroidery™
Software design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the TruEmbroidery™ Software where
you can change colors, as follows:

» Editing apps: TruE™ Studio and TruE™ Modify
» Design apps: TruE™ Create

Below are some situations you may encounter according to the availability of thread definitions, as categorized
above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

IN022 Backgrounds / Bonus Design installs: "The installation failed. The installer
encountered an error..."

When installing the Backgrounds or Bonus Designs installs, you may receive the "The installation failed. The
installer encountered an error..." message.

This is because your TruEmbroidery/Samples folder can only be read - it is not possible to create files or folders
within the Samples folder.

To resolve this issue download and install all the available Smart Update files:

1. Open TruE Configure.
2. Click on the Smart Update button.
3. Follow the on-screen instructions to download and install all the available updates.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in TruE™ Configure and repeat the registration process. This does not change
the registration status of software you have already registered, but it does allow you to change your personal
information and/or dealer information.

Ensure your dongle is connected to your computer before you start, so that your current registration details can
be easily retrieved.

If your dongle is not connected, you will need to enter your e-mail address and password to find your registration
details.



This may occur on an existing installation of the TruE Embroidery System as a result of upgrading to the latest
Mac OS Update.

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery Software section, download the latest TruEmbroiderySoftware221.pkg file.

. Close down all TruEmbroidery System Apps.

. Install the TruEmbroiderySoftware221.pkg file that you just downloaded.

. Open TruE Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.

QOO NOOTHA,WN -
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The ownership of the folder where the motif is saved into is incorrect and needs to be changed. Use the following
instructions to resolve the issue:

. Close all TruEmbroidery apps

. Open Finder.

. Click Applications entry - in the Favorites section near the top left corner of the Finder window.
. On the main area of the window, double click on the Utilities entry in Finder.

. Double click on the Terminal entry.

. Copy the Terminal Text at the end of the section:

. Paste it into Terminal.

. Press Return on your keyboard.

ONOO PR WN -

Terminal Text:
sudo chown -R $USER ~/Library/Application\ Support/VsmSoftware/

TruE Create

Listed versions: 2.1

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System, click on the Users & Groups icon.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right hand pane of that window.

. Click on the + icon on the right hand pane of that window. An Open dialog will appear.

. On the left hand pane - under the Favorites section; click on the Applications entry.

. In the right hand pane, scroll down the list of apps until you come to the TruE Machine entry.

. Select the TruE Machine entry and click on the Add button.

. You will now see TruE Machine in the list of items that will automatically start when you log in.

. Close System Preferences/Users & Groups.

O OWoONO O~
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When you next log into your computer; the TruE Machine app will automatically run.

EC004 Can | connect more than one embroidery machine to my computer with
TruE Machine?

No, there is not the ability to have two embroidery machines connected at the same time; and be able to send a
designs to the first embroidery machine and then to the second embroidery machine.

In a scenario such as that; you are advised to:

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the TruE™ Machine app is running. TruE™ Machine appears as a machine icon in the menu
bar.

If TruE™ Machine is not running, start it.
o Click the TruE™ Machine icon in the Launchpad , or double-click the TruE™ Machine icon in the Finder .
Second, confirm that the TruE™ Machine app is communicating with your embroidery machine.

o Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start TruE™ Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart TruE™ Machine.

EC006 | have sent a design to my embroidery machine, but nothing is
happening.

You can only send a design directly to your embroidery machine if the following folder exists:
[[Home]/TruEmbroidery/TempSend.

If this folder does not exist, do as follows:

1. Open a Finder window.

2. Choose Go > Home.

3. Click the TruEmbroidery folder to open it.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

6. Send the design again.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to save a file in this format that is bigger than the largest available hoop size this message would appear.



GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created
Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has

more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GE002 Some of the items in a menu are dimmed.

Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."
Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you

to choose a color. The color set by default for your TruEmbroidery™ Software is 127, 127, 127 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you
to choose a color. The color set by default for your TruEmbroidery™ Software is 211, 233, 255 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in TruE™ Configure to return the toolbar and windows in the app to their default settings.

To return the icons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the default
icon set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any TruEmbroidery™ Software apps that are open.

2. Click the TruE™ Configure icon in the Launchpad, or double-click the TruE™ Configure icon in the Finder.
3. Click the Utilities tab.

4. Click Reset All Apps.

5. Click the Quit Open TruE Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some TruE apps are still open, a message will appear, saying that some apps appear to be running. Click
OK to close all running TruE apps, or click Cancel.

(o]

The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed



GE007 When | try to use the numbers box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color will be replaced with the nearest match in the
Import Thread Range you have set in TruE™ Configure. You can alter it to any other color if desired. To check for
the latest updates for the TruEmbroidery™ Software, use Smart Update in TruE™ Configure.

GE009 When | open a picture the name is displayed, but | cannot see the picture
and Continue is dimmed.

This can happen if the desired picture is corrupt. For example, it might have an extension such as .bmp or .jpg,
yet not be a proper picture file.

GE010 No dongle attached. Cannot open or use application (7).

This message will appear when trying to start an app if the TruEmbroidery™ Software cannot detect the dongle
(data protection device). Ensure the dongle is plugged into a free USB port of your computer

GE011 No dongle attached. Cannot open or use application (33).

This message may appear if you try to use TruE™ Create shortly after starting or logging into your computer,
before the system is fully ready. Wait for a few seconds and try again.

GE012 The file XX is locked. If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy, click Duplicate.
This message appears when trying to edit an embroidery design outline which is locked, or is on a read-only

medium such as a CD-R. Unlock the embroidery design outline before editing, or duplicate it and then edit it, if it
is on a read-only medium.

GE013 The file XX is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery design outline which is on a read-only medium such
as a CD-R. Duplicate it, then edit and save it.

GE014 The file doesn’t exist.

This message appears if the desired design is not where the app expects it to be, for example if a design was
saved to a network drive, then deleted or renamed.

The message would appear if you tried to load the design from the Open Recent list on the File menu.



GE015 Unrecognized file format.

This message appears if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE016 Unrecognized file extension.

This message may appear if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE017 Background Image Warning. This will remove your existing image,
continue?

This message appears if you try to load a background image when an image has already been loaded. Click OK
to load a new image, or Cancel to use your existing image.

GE018 Background Image Error. Could not open the background image.

This message appears if you try to load a background image and the picture is corrupt. For example, it might
have an extension such as .bmp or .jpg, yet not be a proper picture file.

GE019 The document XX could not be saved as XX. The volume is read only. Try
saving the file to another volume.

This message appears if, for instance, you try to save an embroidery design to a CD-R. A CD-R is read only,
therefore you will not be able to save the embroidery design. Save the embroidery design to another medium .

GE020 The document XX could not be autosaved. The volume is read only. Try
saving the file to another volume. You can also duplicate the document or discard
your changes to close it.

This message appears if, for instance, you have loaded an embroidery design from a CD-R and then attempt to

save the embroidery design back to the CD. A CD-R is read only, therefore you will not be able to save the
embroidery design. Save the embroidery design to another medium .

GE021 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Save has a name that has already been used. Replace
the existing embroidery, or choose a new name before saving.

GE022 Embroidery is too large or will not fit in hoop.

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you choose Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again. Alternatively, change the size
of the hoop.

GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.



GE024 ExportDesign too large for export format. Exporting XX file failed.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE027 Not For Sale. This is a Dealer version of the TruEmbroidery™ Software
and not for retail sale. If you are not a certified registered TruEmbroidery™
Software dealer you are not entitled to use this software. Please contact your
local dealer for further information.

This message means that the app is a dealer only version for demonstration and training purposes, and is not
available for retail sale. Please contact software support for further information.

GE028 Could not understand the string XX.

This message appears if the value entered in a number box is outside the valid range, or is not a number.

GE029 The file doesn’t exist.

This message appears if the desired embroidery is not where the app expects it to be, for example if an
embroidery was saved to a network drive, then deleted or renamed. The message would appear if you tried to
load the embroidery from the Open Recent list on the File menu.

GE039 Information About Colors in TruEmbroidery™ Software Files

The TruEmbroidery™ Software will display threads in a file in the same way on any computer where it is installed.
That is, the colors used will be the same even if they are reproduced slightly differently on different monitors. You
can print a worksheet to see the colors and color names used in a particular design. This is true, even if you do
not have all the threads in a design defined in the database on your computer. This is because a TruEmbroidery™
Software design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

o Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the TruEmbroidery™ Software where
you can change colors, as follows:

» Editing apps: TruE™ Studio and TruE™ Modify
o Design apps: TruE™ Create

Below are some situations you may encounter according to the availability of thread definitions, as categorized
above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.



IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the TruEmbroidery™ Software samples/backgrounds/documents/bonus designs the files
should be installed in subfolders of the folder /Users/Home/TruEmbroidery/ (where Home means the account of
the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

IN022 Backgrounds / Bonus Design installs: "The installation failed. The installer
encountered an error..."

When installing the Backgrounds or Bonus Designs installs, you may receive the "The installation failed. The
installer encountered an error..." message.

This is because your TruEmbroidery/Samples folder can only be read - it is not possible to create files or folders
within the Samples folder.

To resolve this issue download and install all the available Smart Update files:

1. Open TruE Configure.
2. Click on the Smart Update button.
3. Follow the on-screen instructions to download and install all the available updates.

SsT038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop

This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain
hoops of the selected size. Use Hoop Selection to choose the desired hoop size, but do not choose a Universal
Hoop.

TC009 The fill shape created with QuickStitch™ Fill when | click inside the area
is not the one | want

The pictures used should have well differentiated color areas, which should be solid, to fill easily. Clip art is
excellent for this purpose.

If Color Tolerance is switched off then switch it on in TruE Create menu -> Preferences... -> Color Tolerance
for QuickStitch Tools checkbox. Color Tolerance will then allow you to preview any area for QuickStitch™
functions, which should reveal any problems with color areas in the picture. Alter the picture before reloading it as
a Background image. Alternatively, use the FreeHand™ Fill functions to place the Fill Area.

TCco10 How do | change the color of the border of my FreeHand™ or
QuickStitch™ fill area?

To change the color of the border, create the fill area using QuickStitch™ Fill functions. Both the fill area and the
border will use the current thread color.

1. Select the Fill area that you would like to edit.

2. ctrl + click to bring up the context menu.

3. Click Properties to bring up the Fill Properties dialog for that Fill area.
4. Click on the Line tab.

5. Select the Insert Color Change option.



6. Click on the Color Selection button - three colored circles; this will bring up the Color Selection dialog.
7. Select your Thread Color.

8. Click OK to close the Color Selection dialog

9. Click OK again to close the Fill Properties dialog.

Your work area will now show the object has a separate color for the border.

TC024 Error "Trace Failed. Maybe the image is too thick?"

This happens when you use QuickTrace to follow an outline in the picture and then QuickTrace finds a part of
the outline that is very thick. This can be caused by excessively broad outlines or by selecting too much of the
picture with a high Color Tolerance value. In this case, QuickTrace does not know where to trace the outline as
the problem part of the outline is more like a fill area.

Try using a lower Color Tolerance value

TC029 The border shape created with QuickStitch™ functions when | click inside
the area is not the one | want

Use Color Tolerance to preview the area that will be used.

» Solid Colors. A solid color area must have well defined edges, either by having an outline of a different color
or by being enclosed by other colors. Color Tolerance will show where there are gaps in a border around
an area.

» Stippled Colors. Stippled colors (also called 'dithered’ colors) are treated the same as solid color areas.

» Graduated Colors. If Color Tolerance is switched off then you will only be able to select a small, single
colored part of a graduated color. It is also easier to select a graduated color area when it is enclosed by
contrasting colors.

Color Tolerance is switched on with the Color Tolerance for QuickStitch Tools option in TruE Create menu ->
Preferences...

Alternatively, use the relevant Freehand™ function.

TCco61 | did not select all the objects | wanted with Box, Polygon or Freehand
Select

Objects must be fully enclosed by the selection line to be selected as part of a block. If even the smallest part of
an object is outside the line then it will not be selected.

TCco064 | have created satin Border with Satin Line Trace but | can't change the
width of it all at once

Use the FilmStrip and/or slider bars to hide all objects except the satin borders and traveling running stitch used
to create the trace. Select any satin border object in the trace, then ctrl-click in the FilmStrip and select Global

Properties. The Satin Line properties dialog box will appear. Make adjustments as desired and click OK. The
new properties will be applied to all visible satin borders.

TCco65 Color Tolerance does not show me all the lines that will be traced by a
QuickTrace function

The dashed line used by Color Tolerance only shows the outside of the area that is selected by the current
Color Tolerance value. Simply try the QuickTrace function and if the result is not satisfactory then Undo the
result and retry the trace with a higher Color Tolerance.

TCc066 There is no underlay under a fill area



This will happen when you select Gradient or Multi-Gradient Density for a fill area. Underlay stitches are only
generated for fill areas with Normal Density selected. This is because the underlay stitching will spoil the effect of
Gradient or Multi-Gradient Density. With Normal Density selected, some fill areas with intricate outlines or
complex holes may not be able to create underlay.

TCco67 The Gradient or Multi-Gradient Density on my fill area does not change

very smoothly

If you have a fill area with a complex outline then this may cause the stitches to fill unevenly when you select
Gradient or Multi-Gradient density. This is because of the way that the edge of the area interferes with the ideal
spacing of the stitches. Gradient and Multi-Gradient density work best for areas with straight or smoothly curving

sides. You could replace the Fill Area with a Freehand™ Fill, or edit the area to straighten the side that causes the
uneven stitches.

TC077 | am looking for the origin of my fill or specialty fill area, but there is no
orange circle.

The origin is usually shown as a medium orange circle. The origin can be moved anywhere on the work area. Try
Zoom To Fit to see the whole work area.

TCco78 The size of my embroidery in the dialog box is bigger than the height or
width | entered, or the hoop size.

If you edit the outermost areas of a design, for example by changing continuous satin to feathered satin, the size
of the actual embroidery may exceed the original height or width of the design

TCc079 The fill shape created with QuickStitch™ when | click inside the area is
not the one | want."

The pictures used should have well differentiated color areas, which may be solid or stippled, to fill easily. Clipart
is excellent for this purpose. If there is a gap where the same color flows into another area, the fill will not work as
expected. If Color Tolerance is switched off then switch it on in Preferences. Color Tolerance will then allow you to
preview any area for QuickStitch™ functions, which should reveal any problems with color areas in the picture.
You can then alter the picture in a picture editor such as Preview. Alternatively, use the Freehand Fill functions to
place the Fill Area.

TCc080 None of the picture is selected for QuickStitch™ when | click inside a
small color area."

QuickStitch™ will not create an area from part of the picture that is very small or very thin. This is because the
area will either have insignificantly few stitches, or it is not wide enough for stitches to go across it. Use Color
Tolerance, or try editing your picture to enlarge the area, so that it is big enough to be used as a QuickStitch™
area. Alternatively, use single or running stitches. For thin lines, use one of the Trace functions.

TCco081 | am looking for the origin of my fill area, but there is no orange circle.

The origin for a Pattern, Shape, Radial or Spiral fill is usually shown as an orange circle. It may be a different
color, depending the underlying picture or background colors. Also, the origin can be moved anywhere on the
work area. Try Zoom To Fit to see the whole work area.

TCc082 \When | create stitches one of my fill areas doesn't fill completely with
stitches."



Try changing the angle of orientation. Even one degree can be enough to allow the artificial intelligence of the
program to fill the object. Another possibility is to move the start point slightly.

TCc083 \When | use motif fill areas, the design takes a long time to appear.

On slower computers, large or complex motif fill areas may take some time to draw, particularly if there are holes
in the area. This may be noticeable when you create new motif fill areas and when you return to TruE™ Create
from another TruEmbroidery™ Software app.

TCco84 The border line created by QuickStitch™ Satin Line/Running
Stitch/Double Stitch/Triple Stitch when | click inside an area is not the one | want.

The pictures used should have well differentiated color areas, which may be solid or stippled, to fill easily. Clipart
is excellent for this purpose. If there is a gap where the same color flows into another area, the fill will not work. If
Color Tolerance is switched off then switch it on in Screen Preferences. Color Tolerance will then allow you to
preview the border, which should reveal any problems with color areas in the picture. You can then alter the
picture in a picture editor such as Preview. Alternatively, use the Freehand Border functions to place the border.

TCco085 | am trying to change colors for some objects but they don’t appear on the
color worksheet in the Edit window of the Control Panel.

Colors for multicolor gradient density may only be edited by selecting the pattern fill area and changing its
properties. Similarly, the border color for a fill plus border area is on the line tab in the properties box.

Tco86 | have inserted a new point and moved an outline but there is still an
outline in the old position.

Some functions in the Create window create more than one outline at a time, such as Double and Quadruple
Trace. For example, Quadruple Trace puts lines of triple and running stitches directly on top of each other. This
means that if you want to add and move a new point to change a Quadruple Trace then you will have to do so

twice, once for each of the lines. This could also happen if you used Break Apart on a fill area with border, and
then moved one of its points.

TC087 | have pasted a block but it is not the original color.

A color change is only copied when it is part of the selected block. If you paste a block that does not start with a
color change then it will use the color that is active at the point where the block is pasted. If you want to preserve
the color, either copy the relevant color change or use the FilmStrip to insert the desired color.

TCco088 All of my design turned blue when | used Paste into New Window.

Color changes are only transferred if they are within the copied block. If there are no Color changes in a pasted
block then all the objects will use the initial thread color for a new deaign, which is blue.

TC089 | did not select all the objects | wanted with Box, Polygon or Freehand
Select."

Objects must be fully enclosed by the selection line to be selected as part of a block. If even the smallest part of
an object is outside the line then it will not be selected.

TC090 | have created a satin border with Satin Trace but | can't change the width
of it all at once."



Use the FilmStrip, slider bars and Filters to hide all objects except the satin lines and traveling running stitch used
to create the trace. Select any satin line object in the trace, then Control—click in the FilmStrip and select Global
Properties. The properties dialog for Satin Line will appear. Make adjustments as desired and click OK. The new
properties will be applied to all visible satin lines.

TC091 Color Tolerance does not show me all the lines that will be traced by a
QuickTrace function.

The hatched shading used by Color Tolerance may not show on thin lines that are selected by Color Tolerance.
Simply try the QuickTrace function and if the result is not satisfactory then Undo the result and retry the trace with
a higher Color Tolerance value.

TC092 There is no underlay under a fill area.

This will happen when you select Gradient or Multi-Gradient Density for a pattern fill area. Underlay stitches are
only generated for fill areas with Normal Density selected. This is because the underlay stitching will spoil the
effect of Gradient or Multi-Gradient Density.

TCc093 How do | change the border color for a fill area?

The border forms part of a fill area. To change the color of a fill area border, do as follows:

. Select a fill area with a border.

. Control—click the fill area and choose Properties from the context menu.

. Click the Line tab.

. Select Insert Color Change, then click Color Selection .

. In the Color Selection dialog select a new thread color for the border.

. Click OK twice to close the Color Selection dialog and the Properties dialog. The fill now has a differently
colored border.
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TC094 How are trims and ties added to my design?

When you export your design as an embroidery, trims and ties are automatically added between objects.

TCc095 The data is from an incompatible version.

The design outline file was created by a later version of TruE™ Create, or is corrupt. Refer to source of this file for
a solution.

TC096 Some incompatible data was lost.

The design outline file was created by a later version of TruE™ Create, or is corrupt. The design may behave
unpredictably. Refer to source of this file for a solution.

Tc097 The data is not in the correct format.

The design outline file was created by a later version of TruE™ Create, or is corrupt. Refer to source of this file for
a solution.

TC098 Insert Design Error. Failed to load the supplied EDO file.

This message appears if an .edo file cannot be inserted. For example, it might have the extension .edo, yet not be
a proper design outline file.



TC099 Trace Failed. Maybe the image is too thick?

This happens when you use one of the Trace tools (Double Trace, Quadruple Trace, Satin Line Trace or Motif
Line Trace) to follow an outline in the picture and then Trace finds a part of the outline that is very thick. This can
be caused by excessively broad outlines or by selecting too much of the picture with a high Color Tolerance value.
In this case, Trace does not know where to trace the outline as the problem part of the outline is more like a fill
area. Use a lower Color Tolerance value, or change the picture in a picture editor to make the outline thinner or
break up the outline so that the wide parts are isolated from the rest of the outline.

TC100 The start and end points do not line up; add a stitch or rotate?

This message may appear when exporting a running stitch design as a motif, or as a Machine Stitch. Motifs and
machine stitches are usually designed to stitch from left to right, and to start and finish at the same level. This
function allows you to add a stitch, or rotate the design, to ensure the start and end points line up.

TCc101 Delete this motif, are you sure?

This message will appear if you click Delete in the My Motifs part of the Motif window. These are motifs that you
created. If you do not want to delete the selected motif, click No.

Note: The Delete button is dimmed when system motifs are used, or if only one motif is present in My Motifs.

TC102 Machine Stitch. Only Running Stitch lines can be used to create a
machine stitch. Please change your selection or convert objects to Running Line.

This message appears if you try to Export or Send a design as a machine stitch if it contains any stitch type other
than running stitch, or no stitches at all. Only use running stitch when creating machine stitches.

TC103 Error Adding Motif. Only Running Stitch lines can be used to create a
motif. Please change your selection or convert objects to Running Line.

This message appears if you try to create a motif from a design if it contains any stitch type other than running
stitch, or no stitches at all. Only use running stitch when creating motifs.

TCc104 Error Saving Spx. Unable to open the spx file for writing.

This message appears if, for instance, you try to save a machine stitch to a read only medium such as a CD-R. A
CD-R is read only, therefore you will not be able to save the design.

TC105 XX.spx already exists. Do you want to replace it?

This message appears if a machine stitch you are trying to Save has a name that has already been used.
Replace the existing stitch, or choose a new name before saving.

Tc106 Failed to create stitch data.

This message appears if you try to Export a design as a machine stitch and the stitch cannot be created. Check
that your design consists of only running stitch lines.

Tc107 Failed to save stitch file.

This message appears if you try to Export a design as a machine stitch and the stitch cannot be saved. Check
that your design consists of only running stitch lines, and try saving the stitch under a different name in a different
place.



TC108 The value " is invalid. Please provide a valid value.

This message appears in the following circumstances:

« If the Density for Satin Line is below 2mm or above 15mm, or is not a number.

« If the Density for Continuous Satin, Satin Area, MultiWave Fill or Pattern Fill is below 2mm or above 40mm,
or is not a number.

« If the Density for Shape Fill, Radial Fill or Spiral Fill is not a number.

TC109 The value * is too large. Please provide a valid value.

This message appears in the following circumstances:

« If the value entered in the Compensation box in the Continuous Satin, Satin Area or Pattern Fill dialog is
greater than 30.

« If the value entered in the Angle box in the Pattern Fill, Crosshatch Fill or Motif Fill dialog is greater than
360°.

« If the value entered in the Density box in the Shape Fill, Radial Fill or Spiral Fill dialog is greater than 40.

« If the value entered in the Horizontal or Vertical Gap box in the Motif Fill dialog is greater than 100%.

« If the value entered in the Horizontal or Vertical Offset box in the Motif Fill dialog is greater than 50%.

TC110 The value * is too small. Please provide a valid value.

This message appears in the following circumstances:

« If the value entered in the Compensation box in the Continuous Satin, Satin Area or Pattern Fill dialog is
smaller than 0.

If the value entered in the Angle box in the Pattern Fill, Crosshatch Fill or Motif Fill dialog is smaller than 0°.
If the value entered in the Density box in the Shape Fill, Radial Fill or Spiral Fill dialog is smaller than 2.

If the value entered in the Horizontal or Vertical Gap box in the Motif Fill dialog is smaller than -50%.

If the value entered in the Horizontal or Vertical Offset box in the Motif Fill dialog is smaller than -50%.

TC111 The value *mm’ needs to be in the range 0.0 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Minimum Gap box in the Motif Line dialog, or the Motif section of
the Multiwave Fill or Shape Fill dialog is below Omm or above 20mm.

TC112 The value "mm’ needs to be in the range 0.1 to 12 mm. Please provide a
valid value.

This message appears if the size entered in the Zigzag Width box in the Double Stitch With Zigzag Return dialog
or the Crosshatch Fill dialog is below 0.1mm or above 12mm, or is not a number.

TC113 The value *mm’ needs to be in the range 0.2 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the Contour Fill dialog is below 0.2mm or above
5mm.

TC114 The value *mm’ needs to be in the range 0.3 to 6 mm. Please provide a
valid value.



This message appears if the size entered in the Length box in the Running Stitch dialog is below 0.3mm or above
6mm, or is not a number

TC115 The value *mm’ needs to be in the range 1 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the QuiltStipple Fill dialog is below 1mm or above
5mm, or is not a number.

TCc116 The value *mm’ needs to be in the range 1 to 6 mm. Please provide a
valid value.

This message appears if the size entered in the Length box in the Double Stitch, Double Stitch With Zigzag
Return or Triple Stitch dialog, or the Stitch Length box in the MultiWave Fill, Motif Fill, Shape Fill, Crosshatch Fill,
QuiltStipple Fill or Contour Fill dialog is below 1mm or above 6mm, or is not a number.

TC117 The value *mm’ needs to be in the range 1 to 12 mm. Please provide a
valid value.

This message appears if the size entered in the Width box in the Satin Line dialog is below 1mm or above 12mm,
or is not a number.

TCc118 The value *mm’ needs to be in the range 1 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Stitch Length box in the Motif Line dialog is below 1mm or above
20mm, or is not a number.

TC119 The value *mm’ needs to be in the range 2 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the Crosshatch Fill dialog is below 2mm or above
20mm, or is not a number.

TC120 Lettering Error. The character - XX - is not in the font. Please enter a valid
character.

This message appears if the character selected is not in the font. Such characters include square brackets [] and
braces {}. Select a valid character from the popup menu.

TC121 Lettering Error. You must type in a character to create.

This message appears if there is no character in the Letter text box. Enter a valid character, or select a character
from the popup menu.

TC122 The value "mm’ needs to be in the range 3 to 200 mm. Please provide a
valid value.

This message appears if the size entered in the Size box in the Insert Lettter dialog is below 3mm or above
200mm, or is not a number. The Size setting refers to the height in millimeters of an uppercase 'A' in the selected



font. If you wish to increase letter above this you could click and drag one of the corner boxes to resize of rescale
it.

Tc123 Could not create new document for 'Paste into New Window'

This message appears if the object pasted from the Clipboard is not stitch data. It may be from another app.
Make the selection again, then copy and paste it.

Tc124 The document XX could not be saved. No stitch data to save.

This message appears if there are no stitches in your embroidery design. For instance, if you deleted the
embroidery and then tried to save it.

TC125 XX.edo already exists. Do you want to replace it?

This happens when you are doing a Save on an .edo design outline file and you have given the name of a file that
is already there. Click Cancel or Replace as appropriate.

TCc126 Only Running Stitch lines can be used to create a machine stitch. Please
change your selection or convert objects to Running Line.

This message appears if you try to Export or Send a design as a machine stitch if it contains any stitch type other
than running stitch, or no stitches at all. Only use running stitch when creating machine stitches.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE Embroidery System as a result of upgrading to the latest
Mac OS Update.

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery Software section, download the latest TruEmbroiderySoftware221.pkg file.

. Close down all TruEmbroidery System Apps.

. Install the TruEmbroiderySoftware221.pkg file that you just downloaded.

. Open TruE Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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Tc128 \When | create a motif it is not saved

The ownership of the folder where the motif is saved into is incorrect and needs to be changed. Use the following
instructions to resolve the issue:

. Close all TruEmbroidery apps

. Open Finder.

. Click Applications entry - in the Favorites section near the top left corner of the Finder window.
. On the main area of the window, double click on the Utilities entry in Finder.

. Double click on the Terminal entry.

. Copy the Terminal Text at the end of the section:

. Paste it into Terminal.

. Press Return on your keyboard.
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Terminal Text:
sudo chown -R $USER ~/Library/Application\ Support/VsmSoftware/

TrukE Machine

Listed versions: 2.1

EC003 Can | have the TruE Machine app automatically start when | turn on my
computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System, click on the Users & Groups icon.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right hand pane of that window.

. Click on the + icon on the right hand pane of that window. An Open dialog will appear.

. On the left hand pane - under the Favorites section; click on the Applications entry.

. In the right hand pane, scroll down the list of apps until you come to the TruE Machine entry.

. Select the TruE Machine entry and click on the Add button.

. You will now see TruE Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.
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When you next log into your computer; the TruE Machine app will automatically run.

EC004 Can | connect more than one embroidery machine to my computer with
TruE Machine?

No, there is not the ability to have two embroidery machines connected at the same time; and be able to send a
designs to the first embroidery machine and then to the second embroidery machine.

In a scenario such as that; you are advised to:

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the TruE™ Machine app is running. TruE™ Machine appears as a machine icon in the menu
bar.

If TruE™ Machine is not running, start it.
» Click the TruE™ Machine icon in the Launchpad , or double-click the TruE™ Machine icon in the Finder .
Second, confirm that the TruE™ Machine app is communicating with your embroidery machine.

» Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start TruE™ Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart TTuE™ Machine.



EC006 | have sent a design to my embroidery machine, but nothing is
happening.

You can only send a design directly to your embroidery machine if the following folder exists:
[[Home]/TruEmbroidery/TempSend.

If this folder does not exist, do as follows:

1. Open a Finder window.

2. Choose Go > Home.

3. Click the TruEmbroidery folder to open it.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

6. Send the design again.

Now try to send the design again.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.
You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome

MC350E the embroidery files must be placed in the EMB5 folder, while for the MC11000 and MC12000 they must
be placed in the Embf folder.

IN022 Backgrounds / Bonus Design installs: "The installation failed. The installer
encountered an error..."

When installing the Backgrounds or Bonus Designs installs, you may receive the "The installation failed. The
installer encountered an error..." message.

This is because your TruEmbroidery/Samples folder can only be read - it is not possible to create files or folders
within the Samples folder.

To resolve this issue download and install all the available Smart Update files:

1. Open TruE Configure.
2. Click on the Smart Update button.
3. Follow the on-screen instructions to download and install all the available updates.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in TruE™ Configure and repeat the registration process. This does not change
the registration status of software you have already registered, but it does allow you to change your personal
information and/or dealer information.

Ensure your dongle is connected to your computer before you start, so that your current registration details can
be easily retrieved.

If your dongle is not connected, you will need to enter your e-mail address and password to find your registration
details.

TC127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE Embroidery System as a result of upgrading to the latest
Mac OS Update.

To resolve this issue; do the following steps:

1. Go to http://www.truembroidery.com
2. Click on the Downloads link at the top of the page.




. Click on the True Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery Software section, download the latest TruEmbroiderySoftware221.pkg file.

. Close down all TruEmbroidery System Apps.

. Install the TruEmbroiderySoftware221.pkg file that you just downloaded.

. Open TruE Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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The ownership of the folder where the motif is saved into is incorrect and needs to be changed. Use the following
instructions to resolve the issue:

. Close all TruEmbroidery apps

. Open Finder.

. Click Applications entry - in the Favorites section near the top left corner of the Finder window.
. On the main area of the window, double click on the Utilities entry in Finder.

. Double click on the Terminal entry.

. Copy the Terminal Text at the end of the section:

. Paste it into Terminal.

. Press Return on your keyboard.

ONOO O P, WN -

Terminal Text.
sudo chown -R $USER ~/Library/Application\ Support/VsmSoftware/

TruE Modify

Listed versions: 2.1

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System, click on the Users & Groups icon.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right hand pane of that window.

. Click on the + icon on the right hand pane of that window. An Open dialog will appear.

. On the left hand pane - under the Favorites section; click on the Applications entry.

. In the right hand pane, scroll down the list of apps until you come to the TruE Machine entry.

. Select the TruE Machine entry and click on the Add button.

. You will now see TruE Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.
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When you next log into your computer; the TruE Machine app will automatically run.

No, there is not the ability to have two embroidery machines connected at the same time; and be able to send a
designs to the first embroidery machine and then to the second embroidery machine.

In a scenario such as that; you are advised to:



1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the TruE™ Machine app is running. TruE™ Machine appears as a machine icon in the menu
bar.

If TruE™ Machine is not running, start it.
e Click the TruE™ Machine icon in the Launchpad , or double-click the TruE™ Machine icon in the Finder .
Second, confirm that the TruE™ Machine app is communicating with your embroidery machine.

o Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start TruE™ Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart TTuE™ Machine.

EC006 | have sent a design to my embroidery machine, but nothing is
happening.

You can only send a design directly to your embroidery machine if the following folder exists:
[[Home]/TruEmbroidery/TempSend.

If this folder does not exist, do as follows:

1. Open a Finder window.

2. Choose Go > Home.

3. Click the TruEmbroidery folder to open it.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

6. Send the design again.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMBS folder, while for the MC11000 and MC12000 they must
be placed in the Embf folder.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to save a file in this format that is bigger than the largest available hoop size this message would appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors



If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GE001 | cannot open Melco (.exp) files into the TruEmbroidery software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert/View to use those designs in your TruEmbroidery software.

GE002 Some of the items in a menu are dimmed.

Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."
Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you

to choose a color. The color set by default for your TruEmbroidery™ Software is 127, 127, 127 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you
to choose a color. The color set by default for your TruEmbroidery™ Software is 211, 233, 255 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in TruE™ Configure to return the toolbar and windows in the app to their default settings.

To return the icons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the default
icon set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any TruEmbroidery™ Software apps that are open.

2. Click the TruE™ Configure icon in the Launchpad, or double-click the TruE™ Configure icon in the Finder.
3. Click the Utilities tab.

4. Click Reset All Apps.

5. Click the Quit Open TruE Apps button to close all open apps.

6. Click the Reset All Apps button.



Note: If some TruE apps are still open, a message will appear, saying that some apps appear to be running. Click
OK to close all running TruE apps, or click Cancel.

The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 When | try to use the numbers box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color will be replaced with the nearest match in the
Import Thread Range you have set in TruE™ Configure. You can alter it to any other color if desired. To check for
the latest updates for the TruEmbroidery™ Software, use Smart Update in TruE™ Configure.

GE010 No dongle attached. Cannot open or use application (7).

This message will appear when trying to start an app if the TruEmbroidery™ Software cannot detect the dongle
(data protection device). Ensure the dongle is plugged into a free USB port of your computer

GE011 No dongle attached. Cannot open or use application (33).

This message may appear if you try to use TruE™ Create shortly after starting or logging into your computer,
before the system is fully ready. Wait for a few seconds and try again.

GE012 The file XX is locked. If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy, click Duplicate.

This message appears when trying to edit an embroidery design outline which is locked, or is on a read-only
medium such as a CD-R. Unlock the embroidery design outline before editing, or duplicate it and then edit it, if it
is on a read-only medium.

GE013 The file XX is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery design outline which is on a read-only medium such
as a CD-R. Duplicate it, then edit and save it.

GE014 The file doesn’t exist.

This message appears if the desired design is not where the app expects it to be, for example if a design was
saved to a network drive, then deleted or renamed.

The message would appear if you tried to load the design from the Open Recent list on the File menu.



GE015 Unrecognized file format.

This message appears if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE016 Unrecognized file extension.

This message may appear if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE019 The document XX could not be saved as XX. The volume is read only. Try
saving the file to another volume.

This message appears if, for instance, you try to save an embroidery design to a CD-R. A CD-R is read only,
therefore you will not be able to save the embroidery design. Save the embroidery design to another medium .

GE020 The document XX could not be autosaved. The volume is read only. Try
saving the file to another volume. You can also duplicate the document or discard
your changes to close it.

This message appears if, for instance, you have loaded an embroidery design from a CD-R and then attempt to
save the embroidery design back to the CD. A CD-R is read only, therefore you will not be able to save the
embroidery design. Save the embroidery design to another medium .

GE021 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Save has a name that has already been used. Replace
the existing embroidery, or choose a new name before saving.

GE022 Embroidery is too large or will not fit in hoop.

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you choose Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again. Alternatively, change the size
of the hoop.

GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.

GE024 ExportDesign too large for export format. Exporting XX file failed.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE025 Print. Embroidery is too large or will not fit in hoop.



This message appears if the embroidery on screen is partially outside the selected hoop. Move the embroidery
completely within the four blue corners of the work area and try again, or change the hoop size

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE027 Not For Sale. This is a Dealer version of the TruEmbroidery™ Software
and not for retail sale. If you are not a certified registered TruEmbroidery ™
Software dealer you are not entitled to use this software. Please contact your
local dealer for further information.

This message means that the app is a dealer only version for demonstration and training purposes, and is not
available for retail sale. Please contact software support for further information.

GE028 Could not understand the string XX.

This message appears if the value entered in a number box is outside the valid range, or is not a number.

GE029 The file doesn’t exist.

This message appears if the desired embroidery is not where the app expects it to be, for example if an
embroidery was saved to a network drive, then deleted or renamed. The message would appear if you tried to
load the embroidery from the Open Recent list on the File menu.

GE030 Unrecognized file format.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE032 Cannot open stitch file.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE033 Unrecognized file extension.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqvarna Viking/Pfaff embroidery

GE034 Stitch file is corrupt.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE035 Stitch file XY coordinates incorrect.



The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE036 The document "xx" could not be opened.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE037 The file "xx" is locked. If you want to make changes to this document,
click Unlock. To keep the file unchanged and work with a copy, click Duplicate

This message appears when trying to edit an embroidery which is locked, or is on a read-only medium such as a
CD-R. Unlock the embroidery before editing, or duplicate it, and then edit it, if it is on a read-only medium

GE038 The file "xx" is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery which is on a readonly medium such as a CD-R.
Duplicate it, then edit and save it.

GE039 Information About Colors in TruEmbroidery™ Software Files

The TruEmbroidery™ Software will display threads in a file in the same way on any computer where it is installed.
That is, the colors used will be the same even if they are reproduced slightly differently on different monitors. You
can print a worksheet to see the colors and color names used in a particular design. This is true, even if you do
not have all the threads in a design defined in the database on your computer. This is because a TruEmbroidery™
Software design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the TruEmbroidery™ Software where
you can change colors, as follows:

» Editing apps: TruE™ Studio and TruE™ Modify
» Design apps: TruE™ Create

Below are some situations you may encounter according to the availability of thread definitions, as categorized
above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the TruEmbroidery™ Software samples/backgrounds/documents/bonus designs the files
should be installed in subfolders of the folder /Users/Home/TruEmbroidery/ (where Home means the account of
the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.



Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

IN022 Backgrounds / Bonus Design installs: "The installation failed. The installer
encountered an error..."

When installing the Backgrounds or Bonus Designs installs, you may receive the "The installation failed. The
installer encountered an error..." message.

This is because your TruEmbroidery/Samples folder can only be read - it is not possible to create files or folders
within the Samples folder.

To resolve this issue download and install all the available Smart Update files:

1. Open TruE Configure.
2. Click on the Smart Update button.
3. Follow the on-screen instructions to download and install all the available updates.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in TruE™ Configure and repeat the registration process. This does not change
the registration status of software you have already registered, but it does allow you to change your personal
information and/or dealer information.

Ensure your dongle is connected to your computer before you start, so that your current registration details can
be easily retrieved.

If your dongle is not connected, you will need to enter your e-mail address and password to find your registration
details.

sT006 \When | ColorSort an embroidery the number of color blocks produced
varies

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas,
therefore depending on the overlaps, the final number of color blocks may vary, even if you are Combining a
similar number of SuperDesigns or monograms.

ST038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop

This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain
hoops of the selected size. Use Hoop Selection to choose the desired hoop size, but do not choose a Universal
Hoop.

Tc124 The document XX could not be saved. No stitch data to save.

This message appears if there are no stitches in your embroidery design. For instance, if you deleted the
embroidery and then tried to save it.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE Embroidery System as a result of upgrading to the latest
Mac OS Update.

To resolve this issue; do the following steps:
1. Go to http://www.truembroidery.com




. Click on the Downloads link at the top of the page.

. Click on the True Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery Software section, download the latest TruEmbroiderySoftware221.pkg file.

. Close down all TruEmbroidery System Apps.

. Install the TruEmbroiderySoftware221.pkg file that you just downloaded.

. Open TruE Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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Tc128 When | create a motif it is not saved

The ownership of the folder where the motif is saved into is incorrect and needs to be changed. Use the following
instructions to resolve the issue:

. Close all TruEmbroidery apps

. Open Finder.

. Click Applications entry - in the Favorites section near the top left corner of the Finder window.
. On the main area of the window, double click on the Utilities entry in Finder.

. Double click on the Terminal entry.

. Copy the Terminal Text at the end of the section:

. Paste it into Terminal.

. Press Return on your keyboard.
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Terminal Text:
sudo chown -R $USER ~/Library/Application\ Support/VsmSoftware/

TM001 The embroidery | want to work with appears too small on the screen.

Make sure the TruE™ Modify window is maximized by choosing Window > Zoom. Click Zoom To Fit to expand
the hoop so it fills the work area. Also, choose a Hoop Size in Hoop Selection that is suitable to the embroidery
size.

T™M002 | find it hard to select the part of the embroidery | wish to edit.

Many functions of TruE™ Modify can be used to help see sections of embroideries more easily. They include the
Zoom Commands, as well as the Draw Next Color Block and Draw Previous Color Block, Draw Range and Ghost
Mode. The Design Player can also be used to help run through embroideries to find the required stitch or
command. The different methods of selection (Box Select, Select Color, Select Stitches, Freehand Select,
Polygon Select and Make Block From Visible Area) are also useful for different situations.

TM003 | selected part of an embroidery, then tried to Compensate the block. The
compensation has been applied to the whole embroidery, not just the area
selected.

Compensation works on the visible part of an embroidery. Hide stitches with Draw Range, Draw Next Color Block,
or turn colors off by deselecting them in the Color Select area on the Modify window, to isolate a specific area
before using this function.

TM004 | selected part of an embroidery, then tried to Break Up Stitches. Stitches
have been broken up in the whole embroidery, not just the area selected.

Break Up Stitches works on the visible part of an embroidery. Hide stitches with Draw Range, Draw Next Color
Block or turn colors off to isolate a specific area before using this function.



TM005 | cannot select the desired color using the Select Color function, because
one color is on top of the other.

Use Draw Next Color and Draw Previous Color or turn colors off in the Color Select area on the Modify window to
isolate the desired color area, then click Select Color to select those stitches.

TM006 Some of the stabilizing lines on my cutwork are placed in the wrong
sequence.

If you use ColorSort on multiple areas of cutwork with stabilizing lines, in some circumstances the stabilizing lines
may be merged. When changing the order of designs with multiple cutwork areas, use the arrows in Color select
to set the order of the color blocks.

TM007 | used Box Select around an area, but selected some stitches | didn't
want. Undo is dimmed so | can't click it.
To cancel a stitch block selection made using Box Select, Select Color, Freehand Select, Polygon Select or Make

Block From Visible Area, click anywhere in the currently active embroidery, but outside the box showing the
selected stitches. The stitches will no longer be selected.

TruE Studio

Listed versions: 2.1

Ec003 Can | have the TruE Machine app automatically start when | turn on my
computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System, click on the Users & Groups icon.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right hand pane of that window.

. Click on the + icon on the right hand pane of that window. An Open dialog will appear.

. On the left hand pane - under the Favorites section; click on the Applications entry.

. In the right hand pane, scroll down the list of apps until you come to the TruE Machine entry.

. Select the TruE Machine entry and click on the Add button.

. You will now see TruE Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.
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When you next log into your computer; the TruE Machine app will automatically run.

EC004 Can | connect more than one embroidery machine to my computer with
TruE Machine?

No, there is not the ability to have two embroidery machines connected at the same time; and be able to send a
designs to the first embroidery machine and then to the second embroidery machine.

In a scenario such as that; you are advised to:

1. Send the design to the first machine.
2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.



4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the TruE™ Machine app is running. TruE™ Machine appears as a machine icon in the menu
bar.
If TruE™ Machine is not running, start it.

o Click the TruE™ Machine icon in the Launchpad , or double-click the TruE™ Machine icon in the Finder .
Second, confirm that the TruE™ Machine app is communicating with your embroidery machine.

» Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start TruE™ Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart TruE™ Machine.

EC006 | have sent a design to my embroidery machine, but nothing is
happening.

You can only send a design directly to your embroidery machine if the following folder exists:
[[Home]/TruEmbroidery/TempSend.

If this folder does not exist, do as follows:

1. Open a Finder window.

2. Choose Go > Home.

3. Click the TruEmbroidery folder to open it.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

6. Send the design again.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMBS5 folder, while for the MC11000 and MC12000 they must
be placed in the Embf folder.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to save a file in this format that is bigger than the largest available hoop size this message would appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its



format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created
Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has

more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GE001 | cannot open Melco (.exp) files into the TruEmbroidery software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert/View to use those designs in your TruEmbroidery software.

GE002 Some of the items in a menu are dimmed.

Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."
Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you

to choose a color. The color set by default for your TruEmbroidery™ Software is 127, 127, 127 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use TruE™ Configure to change the grid color. Click the Color block and the Colors window appears to allow you
to choose a color. The color set by default for your TruEmbroidery™ Software is 211, 233, 255 (RGB). You can
use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in TruE™ Configure to return the toolbar and windows in the app to their default settings.

To return the icons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the default
icon set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any TruEmbroidery™ Software apps that are open.

2. Click the TruE™ Configure icon in the Launchpad, or double-click the TruE™ Configure icon in the Finder.
3. Click the Utilities tab.

4. Click Reset All Apps.

5. Click the Quit Open TruE Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some TruE apps are still open, a message will appear, saying that some apps appear to be running. Click
OK to close all running TruE apps, or click Cancel.

[o2]

The toolbar and windows in your app will have been restored to their original state.



Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 \When | try to use the numbers box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color will be replaced with the nearest match in the
Import Thread Range you have set in TruE™ Configure. You can alter it to any other color if desired. To check for
the latest updates for the TruEmbroidery™ Software, use Smart Update in TruE™ Configure.

GeE009 When | open a picture the name is displayed, but | cannot see the picture
and Continue is dimmed.

This can happen if the desired picture is corrupt. For example, it might have an extension such as .bmp or .jpg,
yet not be a proper picture file.

GE010 No dongle attached. Cannot open or use application (7).

This message will appear when trying to start an app if the TruEmbroidery™ Software cannot detect the dongle
(data protection device). Ensure the dongle is plugged into a free USB port of your computer

GE011 No dongle attached. Cannot open or use application (33).

This message may appear if you try to use TruE™ Create shortly after starting or logging into your computer,
before the system is fully ready. Wait for a few seconds and try again.

GE012 The file XX is locked. If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy, click Duplicate.

This message appears when trying to edit an embroidery design outline which is locked, or is on a read-only
medium such as a CD-R. Unlock the embroidery design outline before editing, or duplicate it and then edit it, if it
is on a read-only medium.

GE013 The file XX is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery design outline which is on a read-only medium such
as a CD-R. Duplicate it, then edit and save it.

GE014 The file doesn’t exist.



This message appears if the desired design is not where the app expects it to be, for example if a design was
saved to a network drive, then deleted or renamed.

The message would appear if you tried to load the design from the Open Recent list on the File menu.

GE015 Unrecognized file format.

This message appears if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE016 Unrecognized file extension.

This message may appear if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE017 Background Image Warning. This will remove your existing image,
continue?

This message appears if you try to load a background image when an image has already been loaded. Click OK
to load a new image, or Cancel to use your existing image.

GE018 Background Image Error. Could not open the background image.

This message appears if you try to load a background image and the picture is corrupt. For example, it might
have an extension such as .bmp or .jpg, yet not be a proper picture file.

GE019 The document XX could not be saved as XX. The volume is read only. Try
saving the file to another volume.

This message appears if, for instance, you try to save an embroidery design to a CD-R. A CD-R is read only,
therefore you will not be able to save the embroidery design. Save the embroidery design to another medium .

GE020 The document XX could not be autosaved. The volume is read only. Try
saving the file to another volume. You can also duplicate the document or discard
your changes to close it.

This message appears if, for instance, you have loaded an embroidery design from a CD-R and then attempt to

save the embroidery design back to the CD. A CD-R is read only, therefore you will not be able to save the
embroidery design. Save the embroidery design to another medium .

GE021 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Save has a name that has already been used. Replace
the existing embroidery, or choose a new name before saving.

GE022 Embroidery is too large or will not fit in hoop.

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you choose Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again. Alternatively, change the size
of the hoop.



GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.

GE024 ExportDesign too large for export format. Exporting XX file failed.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE025 Print. Embroidery is too large or will not fit in hoop.

This message appears if the embroidery on screen is partially outside the selected hoop. Move the embroidery
completely within the four blue corners of the work area and try again, or change the hoop size

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE027 Not For Sale. This is a Dealer version of the TruEmbroidery™ Software
and not for retail sale. If you are not a certified registered TruEmbroidery ™
Software dealer you are not entitled to use this software. Please contact your
local dealer for further information.

This message means that the app is a dealer only version for demonstration and training purposes, and is not
available for retail sale. Please contact software support for further information.

GE028 Could not understand the string XX.

This message appears if the value entered in a number box is outside the valid range, or is not a number.

GE029 The file doesn’t exist.

This message appears if the desired embroidery is not where the app expects it to be, for example if an
embroidery was saved to a network drive, then deleted or renamed. The message would appear if you tried to
load the embroidery from the Open Recent list on the File menu.

GE030 Unrecognized file format.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE032 Cannot open stitch file.



This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE033 Unrecognized file extension.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqvarna Viking/Pfaff embroidery

GE034 Stitch file is corrupt.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE035 Stitch file XY coordinates incorrect.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE036 The document "xx" could not be opened.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp3, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE037 The file "xx" is locked. If you want to make changes to this document,
click Unlock. To keep the file unchanged and work with a copy, click Duplicate

This message appears when trying to edit an embroidery which is locked, or is on a read-only medium such as a
CD-R. Unlock the embroidery before editing, or duplicate it, and then edit it, if it is on a read-only medium

GE038 The file "xx" is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery which is on a readonly medium such as a CD-R.
Duplicate it, then edit and save it.

GE039 Information About Colors in TruEmbroidery™ Software Files

The TruEmbroidery™ Software will display threads in a file in the same way on any computer where it is installed.
That is, the colors used will be the same even if they are reproduced slightly differently on different monitors. You
can print a worksheet to see the colors and color names used in a particular design. This is true, even if you do
not have all the threads in a design defined in the database on your computer. This is because a TruEmbroidery™
Software design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the TruEmbroidery™ Software where
you can change colors, as follows:

» Editing apps: TruE™ Studio and TruE™ Modify
o Design apps: TruE™ Create

Below are some situations you may encounter according to the availability of thread definitions, as categorized
above.



GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the TruEmbroidery™ Software samples/backgrounds/documents/bonus designs the files
should be installed in subfolders of the folder /Users/Home/TruEmbroidery/ (where Home means the account of
the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

IN022 Backgrounds / Bonus Design installs: "The installation failed. The installer
encountered an error..."

When installing the Backgrounds or Bonus Designs installs, you may receive the "The installation failed. The
installer encountered an error..." message.

This is because your TruEmbroidery/Samples folder can only be read - it is not possible to create files or folders
within the Samples folder.

To resolve this issue download and install all the available Smart Update files:

1. Open TruE Configure.
2. Click on the Smart Update button.
3. Follow the on-screen instructions to download and install all the available updates.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in TruE™ Configure and repeat the registration process. This does not change
the registration status of software you have already registered, but it does allow you to change your personal
information and/or dealer information.

Ensure your dongle is connected to your computer before you start, so that your current registration details can
be easily retrieved.

If your dongle is not connected, you will need to enter your e-mail address and password to find your registration
details.

sT004 ColorSort does not work for the multi-color monogram that | created

When creating multi-color lettering, ensure that the Trim Connection is selected. If Running Connection is
selected, you will not be able to ColorSort the lettering.

sT006 \When | ColorSort an embroidery the number of color blocks produced
varies
The ColorSort process does not just put the same color blocks together. It checks for overlap between areas,

therefore depending on the overlaps, the final number of color blocks may vary, even if you are Combining a
similar number of SuperDesigns or monograms.



sT011 Error: "Embroidery is too large or is not in the hoop"

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again.

sT012 Error: "Embroidery is too large or is not in the hoop" when printing

This error can occur when an embroidery design(s) are partially outside of the hoop area when you try to print.

Move the design(s) so that they are entirely within the hoop area; or alternatively use a larger hoop.

sT018 The embroidery | want to work with appears too small on the screen

Make sure the TruE Studio window is maximized by clicking the Maximize icon on the title bar. Click Zoom To Fit
to expand the hoop so it fills the work area. Also, choose a Hoop Size in Hoop Selection that is suitable to the
embroidery size.

sT019 | find it hard to select the part of the embroidery | wish to edit

Many functions of TruE Studio can be used to help see sections of embroideries more easily. They include the
Zoom Commands. The different methods of selection (Box Select, Freehand Select, Polygon Select and Select
All) are also useful for different situations.

ST029 | have increased the Gap setting, but the lowercase characters are still
touching each other

For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script fonts use a special
‘continuous' joining method, which places lowercase characters adjacent to each other to give the appearance of
handwriting. All the fonts in the Script category use this joining method.

sT030 All the lettering appears in uppercase, even though | have typed
lowercase characters in the Letters box

You are using an uppercase font. In an uppercase font (with UC in the name), all the lowercase characters are
identical to the uppercase characters.

sT038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop

This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain
hoops of the selected size. Use Hoop Selection to choose the desired hoop size, but do not choose a Universal
Hoop.

ST043 The Mirror option does not seem to have any effect in the Encore
function.
If your embroidery is horizontally symmetrical before you use the Encore function, the Mirror option will have no

apparent effect. However, it will affect stitch order of each alternate copy. For example, clockwise stitching will
become counter-clockwise, and so on.



ST044 The value *mm’ needs to be in the range 3 to 200 mm. Please provide a
valid value.

This message appears if the size entered in the Size Box on the Letter window of the Control Panel, or in the
Letter Properties dialog is below 3mm or above 200mm, or is not a number. The Size setting refers to the height
in millimeters of an uppercase 'A' in the selected font. If you wish to increase lettering above this you could click
and drag one of the corner boxes or alter the Height or Width proportions.

ST045 The value *mm’ needs to be in the range 1 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Line Spacing box in the Letter Letter Options or Letter Properties
dialog is below 1mm or above 5mm, or is not a humber.

ST046 The value ™ is invalid. Please provide a valid value.

This message appears if the value entered in the height or width box in the Letter Options or Letter Properties
dialog is not a number.

sT047 The value ™ is invalid. Please provide a valid value.

This message appears if the value entered in the height or width box on the SuperDesign window of the Control
Panel, or in the SuperDesign Properties dialog, is not a number.

ST048 The value *mm’ needs to be in the range 5 to 200 mm. Please provide a
valid value."

This message appears if the size entered in the Size Box on the SuperDesign window of the Control Panel, or in
the SuperDesign Properties dialog, is below 5mm or above 200mm, or is not a number. The Size setting refers to
the height in millimeters of the selected SuperDesign. If you wish to increase the size above this you could click
and drag one of the corner boxes or alter the Height or Width proportions.

ST049 The value * is too small. Please provide a valid value.

This message appears if the value entered in the height or width box on the SuperDesign window of the Control
Panel, or in the SuperDesign Properties dialog, is smaller than 25%.

sT050 The value * is too large. Please provide a valid value.

This message appears if the value entered in the height or width box on the SuperDesign window of the Control
Panel, or in the SuperDesign Properties dialog, is greater than 400%.

sT051 The value " is invalid. Please provide a valid value.

This message appears if the value entered in the height or width box in the Frame Options or Frame Properties
dialog is not a number.

SsT052 The value mm’ needs to be in the range 5 to 200 mm. Please provide a
valid value.

This message appears if the size entered in the Size Box in the Frame Options or Frame Properties dialog is
below 5mm or above 200mm, or is not a number. The Size setting refers to the height in millimeters of the



selected Frame. If you wish to increase the size above this you could click and drag one of the corner boxes or
alter the Height or Width proportions.

sT053 The value "mm’ needs to be in the range -50 to 50 mm. Please provide a
valid value

This message appears if the size entered in the Margin box on the Frame window of the Control Panel is below
-50mm or above 50mm.

ST054 The value * is too small. Please provide a valid value.

This message appears if the value entered in the height or width box in the Frame Options or Frame Properties
dialog is smaller than 25%.

sT055 The value * is too large. Please provide a valid value.

This message appears if the value entered in the height or width box in the Frame Options or Frame Properties
dialog is greater than 400%.

SsT056 The value "mm’ needs to be in the range -50 to 50 mm. Please provide a
valid value."

This message appears if the size entered in the Margin box on the Border window of the Control Panel is below
-50mm or above 50mm.

sT067 The selected dimensions will produce a large PortraitStitch and stitch
creation may take some time. Transparent background areas will reduce the time
required.

This message will appear if you specify a PortraitStitch larger than 26000mm square. Click OK to continue

creating the Portrait. To reduce the stitch creation time, use a picture editor such as Preview to remove the picture
background, particularly any very detailed areas.

sT068 | find it hard to select the embroidery | wish to edit.

Many functions of TruE™ Studio can be used to help see embroideries more easily. They include the Zoom
Commands and the different methods of selection (Box Select, Freehand Select and Polygon Select. Use
Command and the left or right arrow (38« or $—) to select each embroidery in turn.

sT069 Certain functions don't seem to work all the time.

Some functions, such as the Design Player and alignment tools, are only available when one or more
embroideries are selected. To use these functions, select one or more embroideries first.

sT070 I've selected the wrong embroidery to move or manipulate.

To deselect an embroidery, click the mouse outside the embroidery, or on another embroidery. To select the
desired embroidery, click on it and an outline box will appear. If one embroidery or piece of lettering is overlapping
another making it difficult to select, use Command and the left or right arrow (38« or 3 —) to select each
embroidery in turn.



sT071 The Color Select area on the Design window appears blank.

If no design is selected, or more than one design is selected, the Color Select area on the Design window will be
blank. To change the threads in an embroidery, select the single embroidery, then view the threads in the Color
Select area.

sT072 | did not select all the embroideries | wanted with Box, Polygon or
Freehand Select.

The embroideries must be fully enclosed by the selection line to be selected as part of a block. If even the
smallest part of an embroidery is outside the line, then it will not be selected.

sT073 | want to change the design that has been used in the corners in Encore.

In Encore Shape and Encore Hoop, when two embroideries are selected, the embroidery that is first in the
stitchout order will be placed in the corners. If you want to use the other embroidery in the corners, use Layout
Order to change the order.

sT074 Not all of my designs have been used in the Encore function.

A maximum of two designs can be used with Encore Shape and Encore Hoop. If more than two designs are
selected, only the first two that were loaded will be used in the Encore. Either use Encore Circle or Line, or
combine some of the embroideries before using Encore.

sT075 | cannot use some other functions when previewing Encored designs.

While in Preview mode it is not possible to select any other tab on the control panel, or many other functions. If
you use the design viewer, the Encore will be cancelled.

sT076 | don’'t remember which font | used when making an embroidery.

Information on the font, SuperDesign, Frame or Border used in an embroidery made in TruE™ Studio is stored in
the Settings. Open the embroidery, then click the Settings tab and Edit in the Design window to view the full text
of the settings. Alternatively, print a worksheet for the embroidery.

sT077 | want to change the size of the lettering, but the control boxes have no
effect.

For the following Line Types, there are no control boxes to change the size of the characters in the lettering:

e Circle Clockwise

« Circle Clockwise

« Full Circle

» Fit To Straight Line
» Fit To Wavy Line

Instead, use Size, Height and Width in Letter Properties to change the size of the characters.

sT078 | want to change the appearance of the font stitching, but the Stitch Type
drop-down is not available.

Some fonts have non-editable properties. For example, they may use more than one pattern for satin or fill, or use
the same fill pattern at different angles in different characters. Therefore, there is no overall uniform property that
can be changed, so the properties dialog box may not be used to change the stitch Properties. You may wish to
use a different font with a similar style that allows you to change its properties.



sT079 When I try to change the stitch properties the Stitch Type drop-down is
dimmed (unavailable).

You are trying to change a property in a font that is not editable. For instance, if a font uses more than one type of
Pattern Fill, the stitch type will be unavailable. Also, if a font is an outline font of running, double or triple stitch, no
fill or satin properties will be available.

sT080 All the lettering appears in lowercase, even though | have typed
uppercase characters in the Letters box.

You are using an lowercase font. In a lowercase font (with LC in the name), all the uppercase characters are
identical to the lowercase characters.

sT081 | have placed multiple pieces of lettering with different text in each item
and | want to change the text that appears in some of them. However, the text in
the Letters box stays the same when | select earlier pieces of lettering.

Select the desired lettering, then Control—click the lettering and choose Properties. The Letter Properties appears
and you may change the text.

Note: Once lettering has been converted to embroidery when it is Saved or Combined, no adjustments can be
made with Letter Properties.

sT083 | want to rotate and mirror my lettering, SuperDesign or frame, but once |
do this | can no longer change its propeties.

When lettering, SuperDesigns and frames are rotated or mirrored, they are 'fixed' as embroideries. Make any
changes to the properties of your lettering, SuperDesign or frame before rotating or mirroring it.

sT084 | copied my lettering, SuperDesign or frame, but | could not edit the
properties of the copy.

When lettering, SuperDesigns and frames are copied, the copy is 'fixed' as an embroidery. If you want to change
the properties of both copies, create the second copy in the Letter, SuperDesign or Frame window.

sT085 | have ColorSorted my lettering and now | can no longer change its
properties.

When lettering is ColorSorted it is 'fixed' as an embroidery. Make any desired adjustments to your lettering before
using ColorSort.

sT086 | have adjusted my lettering on the work area, but when | change the
Letter Properties, the lettering changes shape a little.

The control boxes on blocks of lettering allow subtle adjustments directly to the shape of the lettering. However,
the Letter Properties only allows the proportions of Height and Width to be adjusted. When the Letter Properties
are changed, the previous adjustments may be partially lost when the Height and Width values are applied.
Therefore, it is recommended to make all desired adjustments in Letter Properties before making final
adjustments directly with the control boxes.



sT087 In Letter Options | tried to edit the Stitch Type for my lettering, but the
drop-down menu was dimmed.

If a font does not use an editable stitch type, the Stitch Type will not be available in Letter Options

sT088 In Letter Properties | tried to edit the Stitch Type for my lettering, but there
was no drop-down menu.

Stitch types are not available in the Letter Properties dialog box. Control—click the lettering, and select the stitch
type from the context menu.

sT089 | used Control—click to open the context menu for my lettering, but | could
not choose the stitch type.

If a font does not use an editable stitch type, no stitch type will be available in the context menu.

sT090 | changed a color in my embroidery, but do not like the new color. Undo is
dimmed on the Edit menu so | can't choose it.

To cancel some actions, click outside the currently active embroidery. Then choose Undo. Alternatively, Control—
click the embroidery and choose Undo from the context menu.

sT1091 When | ColorSort an embroidery the number of color blocks produced
varies.

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas.
Therefore depending on the overlaps, the final number of color blocks may vary, even if you have Combined
exactly the same embroideries, lettering or SuperDesigns.

TC101 Delete this motif, are you sure?

This message will appear if you click Delete in the My Motifs part of the Motif window. These are motifs that you
created. If you do not want to delete the selected motif, click No.

Note: The Delete button is dimmed when system motifs are used, or if only one motif is present in My Motifs.

TC108 The value ™ is invalid. Please provide a valid value.

This message appears in the following circumstances:

« If the Density for Satin Line is below 2mm or above 15mm, or is not a number.

« If the Density for Continuous Satin, Satin Area, MultiWave Fill or Pattern Fill is below 2mm or above 40mm,
or is not a number.

« If the Density for Shape Fill, Radial Fill or Spiral Fill is not a number.

TC109 The value * is too large. Please provide a valid value.

This message appears in the following circumstances:

« If the value entered in the Compensation box in the Continuous Satin, Satin Area or Pattern Fill dialog is
greater than 30.

« If the value entered in the Angle box in the Pattern Fill, Crosshatch Fill or Motif Fill dialog is greater than
360°.

« If the value entered in the Density box in the Shape Fill, Radial Fill or Spiral Fill dialog is greater than 40.



« If the value entered in the Horizontal or Vertical Gap box in the Motif Fill dialog is greater than 100%.
« If the value entered in the Horizontal or Vertical Offset box in the Motif Fill dialog is greater than 50%.

TC110 The value * is too small. Please provide a valid value.

This message appears in the following circumstances:

« If the value entered in the Compensation box in the Continuous Satin, Satin Area or Pattern Fill dialog is
smaller than 0.

If the value entered in the Angle box in the Pattern Fill, Crosshatch Fill or Motif Fill dialog is smaller than 0°.
If the value entered in the Density box in the Shape Fill, Radial Fill or Spiral Fill dialog is smaller than 2.

If the value entered in the Horizontal or Vertical Gap box in the Motif Fill dialog is smaller than -50%.

If the value entered in the Horizontal or Vertical Offset box in the Motif Fill dialog is smaller than -50%.

TC111 The value "mm’ needs to be in the range 0.0 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Minimum Gap box in the Motif Line dialog, or the Motif section of
the Multiwave Fill or Shape Fill dialog is below Omm or above 20mm.

TC112 The value *mm’ needs to be in the range 0.1 to 12 mm. Please provide a
valid value.

This message appears if the size entered in the Zigzag Width box in the Double Stitch With Zigzag Return dialog
or the Crosshatch Fill dialog is below 0.1mm or above 12mm, or is not a number.

TC113 The value mm’ needs to be in the range 0.2 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the Contour Fill dialog is below 0.2mm or above
5mm.

TC114 The value mm’ needs to be in the range 0.3 to 6 mm. Please provide a
valid value.

This message appears if the size entered in the Length box in the Running Stitch dialog is below 0.3mm or above
6mm, or is not a number

TC115 The value *mm’ needs to be in the range 1 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the QuiltStipple Fill dialog is below 1mm or above
5mm, or is not a number.

TCc116 The value *mm’ needs to be in the range 1 to 6 mm. Please provide a
valid value.
This message appears if the size entered in the Length box in the Double Stitch, Double Stitch With Zigzag

Return or Triple Stitch dialog, or the Stitch Length box in the MultiWave Fill, Motif Fill, Shape Fill, Crosshatch Fill,
QuiltStipple Fill or Contour Fill dialog is below 1mm or above 6mm, or is not a number.



TC117 The value *mm’ needs to be in the range 1 to 12 mm. Please provide a
valid value.

This message appears if the size entered in the Width box in the Satin Line dialog is below 1mm or above 12mm,
or is not a number.

TCc118 The value *mm’ needs to be in the range 1 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Stitch Length box in the Motif Line dialog is below 1mm or above
20mm, or is not a number.

TC119 The value *mm’ needs to be in the range 2 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the Crosshatch Fill dialog is below 2mm or above
20mm, or is not a number.

Tc124 The document XX could not be saved. No stitch data to save.

This message appears if there are no stitches in your embroidery design. For instance, if you deleted the
embroidery and then tried to save it.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE Embroidery System as a result of upgrading to the latest
Mac OS Update.

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery Software section, download the latest TruEmbroiderySoftware221.pkg file.

. Close down all TruEmbroidery System Apps.

. Install the TruEmbroiderySoftware221.pkg file that you just downloaded.

. Open TruE Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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Tc128 When | create a motif it is not saved

The ownership of the folder where the motif is saved into is incorrect and needs to be changed. Use the following
instructions to resolve the issue:

. Close all TruEmbroidery apps

. Open Finder.

. Click Applications entry - in the Favorites section near the top left corner of the Finder window.
. On the main area of the window, double click on the Utilities entry in Finder.

. Double click on the Terminal entry.

. Copy the Terminal Text at the end of the section:

. Paste it into Terminal.

. Press Return on your keyboard.
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Terminal Text:
sudo chown -R $USER ~/Library/Application\ Support/VsmSoftware/



